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Tutorial 1: Umberto – Basic functions

Time: 1 h / Pages: 20 / Level: New User / Requirements: none
What you will learn:
•
Umberto work area and window handling
•
Create a project, a model and a first process
•
Specify a process
•
Calculate a small model
•
View the calculation results
•
Create Sankey diagrams
•
Use the Module Gallery

Tutorial 2a: Umberto LCA functions

Tutorial 2b: Umberto Cost functions

Time: 3-4 h / Pages: 86 / Level: Beginner

Time: 3-4 h / Pages: 45 / Level: Beginner

Requirements: Tutorial 1 or experience with
Umberto and general knowledge about LCA.

Requirements: Tutorial 1 or experience with
Umberto.

What you will learn:
•
Working with activity datasets
•
Product life cycle phases
•
LCIA calculation and results
•
Disposal and transport activities
•
Function and parameters
•
Allocations
•
Generic materials
•
Co-products
•
Working with functional units
•
Sankey diagrams
•
Print and export results
•
Advanced Features

What you will learn:
•
User defined process specification
•
Create subnets
•
Analysis of input/output inventory
•
Function and parameters
•
Cost accounting for MFA
•
Allocations
•
Generic materials
•
Co-products
•
Sankey diagrams
•
Advanced Features

Tutorial 3: Integrating Costs and LCA in Umberto
Time: 1-2 h / Pages: 20 / Level: Advanced
Requirements: Tutorial 1 and 2 or experience with Umberto and knowledge about LCA.
What you will learn:
•
Integrate costs LCA
•
Material Mapping
•
Calculate Selection

Tutorial 4: Material Flow Cost Accounting (MFCA) with Umberto
Time: 4-5 h / Pages: 72 / Level: Advanced
Requirements: Tutorial 1 and 2b or experience with Umberto and general knowledge about MFCA.
What you will learn:
•
MFCA introduction
•
MFCA in Umberto
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Introduction
Welcome to the tutorial section of Umberto.
It is divided into four independent tutorials of increasing complexity. Each
tutorial has its focus on a different topic. The first tutorial introduces the basic
features of Umberto. The following tutorials provide more complex modeling and
information about advanced features.
The first tutorial gives an introduction on how to create a basic model as well as
the handling of general settings. This is done by using a simple example.
In the second tutorial (2a) the focus is set on the creation of a model for a Life
Cycle Assessment (LCA). It is shown how to work with a database and how to
use different impact assessment methods. In the second tutorial (2b) the focus
is set on cost accounting and efficiency analysis. Part of both second tutorials is
also to visualize the results via Sankey diagrams.
The third tutorial has the main focus on the integration of costs into LCA and
therefore required material mapping.
The fourth tutorial will provide an introduction into the topic of Material Flow
Cost Accounting (MFCA) and the realization of MFCA projects with Umberto. This
tutorial is a stand-alone tutorial designed for new Umberto practitioners who
directly want to start with MFCA calculations.

To be able to learn how to use Umberto the examples presented in
the three tutorials are designed to be independent of LCI databases
that require a license. Hence, the activity datasets used in the
tutorials 2 and 3 are sample datasets with fictitious values that can
be used even without having access to ecoinvent data.
If you want, you can change the user interface language from
English to German. You can find the option in ‘Tools’ → ‘Options’ →
‘Application’.

For more information about the functions covered in this tutorial
have a look at the Umberto User Manual. The user manual can be
accessed directly in the software via the Help menu.
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Tutorial 1: Simple Network Model
This tutorial covers the basic handling of Umberto. It is also shown how to create
a first simple model. Therefore, the tutorial starts with a simple example which
is not exemplary for a typical LCA, Material Flow Analysis (MFA) or MFCA
calculation. Nevertheless, it successfully demonstrates the basics of how to work
with the software Umberto.

Content
•
•
•
•
•
•

Umberto work area and windows
Create, rename or delete a project, a model, a module and a material
Create, rename or delete a net element
Building up a graphical network model
Calculate a network model
Analyzing calculation results

Getting Started
The first thing that appears after opening Umberto is the start page. This page
offers some information about the software and provides links to commands for
creating a new Umberto project file as well as to opening the example project
files of this tutorial.
In Umberto, the topmost data structure is a project file. A project file is a
database where the models and materials are stored in. Several models can be
created in one project file. A model typically contains one network for
calculation. Every material defined in a project can be used for every model
within one project.
All changes made while working on a project are instantly written
in the project database. Therefore, it is not necessary to actively
save the working progress.
Before a model can be created, a new Umberto project file needs to be opened.
There are three ways to do that. Either follow the link New Umberto Project File
on the start page, or navigate to File in the menu bar and choose the entry New.
The third possibility is to click on the New Project File button
in the main
toolbar at the top.
A file save dialog will show asking whether to save the project file on the hard
drive. Please find an adequate name for the Umberto project file, such as
Tutorial 1.
Now that a new project file has been opened, the graphical user interface of
Umberto shows the workspace: There are four windows on the screen.
Tutorial 1
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Specification Editor

Figure 1: Graphical User Interface of Umberto

The largest window is called Net Editor. The net editor allows for creating a
graphical model.
The window pane on the top left is the so-called Project Explorer. It shows all
models and materials which are contained in the respective Umberto project
file.
At the bottom left there is the Property Editor window pane. The first information
on the top of this window shows the type and name of the selected element.
Further properties of this element are also displayed and can be edited here.
Below the net editor the Specification Editor is located. It allows for specifying
the elements of the model. This pane is also used to show the calculation results.
Since no network has been created yet, the specification editor is empty.
A model can be renamed by selecting it within the Project Explorer.
Navigate to the Property Editor, type a new name into the name
field and confirm by pressing the return key or by simply leaving
the field.

To create a new model within the current project, select the folder
Models in the Project Explorer and choose New Model from the
context menu, which can be opened by right clicking. Otherwise,
press the New Model button
in the Project Explorer toolbar.
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Creating a Network Model
After having created a new project and a new model, please start to build the
first network model. In this example, processes that supply a system reference
flow in a simple production chain will be developed. There will be an input
material which will be processed in two production steps.
Start by clicking on the process symbol
in the toolbar of the Net Editor. The
cursor changes to a cross, indicating that the design mode is active. Next, click
in the middle of the net editor to draw the first process.
To draw several elements in a row without exiting the editing mode,
double-click on the desired element in the toolbar. After doubleclicking on an element, a small pin is shown in the button icon
indicating that multiple elements can be created
→
. To exit
the multi-draw mode, use the right mouse button.
Name the process by clicking the process's text label located right below the
process. Navigate to the property editor and enter the name Process 1 in the
field Text. It is also possible to change a text label by clicking on its text while
it is selected. Apply the change by hitting the tab key or by clicking elsewhere
in the net editor.

Figure 2: A first process

The process will need an input place and an output place. Choose the input place
(symbol
with a green circle and a vertical line on the left) and place it left of
the process by clicking there. Then, select the output place from the toolbar
(symbol
with a red circle and a vertical line on the right) and place it on the
right side of the process. Name the elements Input and Output, respectively.
Another way to create elements is to use the Draw menu and to
select the desired element. Alternatively, choose Draw from the
context menu which pops up by right clicking on the area of the
model editor.
The next step is to connect the three elements with arrows, on which the
materials or substances flow into and out of the process. As a general rule,
places always connect to a process, and processes always connect to a place.
Never does an arrow connect a place directly to another place, or a process
directly to another process.

Tutorial 1
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To connect the input place to the process with an arrow, click the arrow button
in the toolbar. Place the cursor over the input place. When a grey filling
appears, drag the cursor onto the process symbol (keeping the left mouse
button pressed). Watch the arrow emerging from the element. When the cursor
comes close to a connectable target element, the arrow snaps to this element
automatically as the mouse button is released: the two elements are now
connected with an arrow leading from the input place to the process.
In the same way, draw an arrow from the process to the output place. The first
very simple network model should now look like Figure 3 below.

Figure 3: A process with inputs and outputs, the start of a process chain

The process shows a small red warning sign. This means that the process is
unspecified.
The function Snap to Grid
in the net editor's toolbar can be used
to easily align elements. By default, this feature is enabled which is
indicated by a blue square around the symbol. To disable this
feature, click on the symbol and the blue square will disappear. The
grid to which the elements are aligned can also be enabled and
disabled by using the Show Grid button .
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Defining Materials
To specify a process, it is necessary to add materials to the process as inputs or
outputs and to specify their quantitative relationship.
Depending on the Version, Umberto may come with a large database of
materials (master material data from ecoinvent v3) which can be used to create
LCA models. However, in this example it is demonstrated how to create new
materials. Materials are categorized into material groups. Material groups are
shown as folders
in the Project Explorer.
The material group Project Materials contains all materials used within a project.
In the Project Explorer, select the folder Project Materials.
Press the New Material button
in the Project Explorer's toolbar or use the
context menu to create a new material.

Figure 4: Project Explorer

The properties of the material are managed in the Properties editor (situated
below the Project Explorer). Rename the material to input material. At this
stage of the tutorial, there is no need to change other material properties.
Create a second material entry named product.

Tutorial 1
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Figure 5: Property Editor

Material groups and sub groups can be created by selecting a
directory for the group within the Project Explorer and pressing the
New Material Group symbol
on the Project Explorer's toolbar.
Another option is using the context menu to create a new material
group by pressing the right mouse button. Material groups are
useful for large projects with a variety of materials.
A material group can be named and renamed by selecting it and
editing the name field within the Property Editor.
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Specifying Process
To specify the process with input and output material entries, click on the
process in the Net Editor. When a process is selected, the Specification pane
below the Net Editor shows two sections: the left section for the inputs of the
process and the right section for its outputs (see Figure 6).
Materials from the materials list can easily be added to the input or output side
using drag&drop. Click and hold the left mouse button on the material input
material in the Project Materials group and drag it to the input section of the
Specification Editor. When a little square with a plus sign appears near the
cursor, release the mouse button. The material is then added to the input
section of the process.
Proceed the same way with the material product and add it to the output
section of the process.
Materials can also be added to a process using the
button at
the bottom of the Specification Editor below the table. This button
prompts a dialog which allows searching for materials by group,
name, display unit and source.
As there is still a warning marker on the process element, the process is not yet
fully specified. It is necessary to determine the ratio between the input and
output materials. This can be done by adding coefficients to the materials in the
specification pane of this process.
In this first illustrative example, the quantity of the input material and the
quantity of the output material (product) are defined to be equal. This means
that there are no additional inputs or outputs (e.g. losses, reject). It is, however,
not required to specifically enter a coefficient 1.00, because the actual flow
quantity is determined in each calculation by the actual process level or quantity
of the product being produced. Hence, the process specification is nothing more
than a ‘recipe’ that is linearly scaled up or down.
For the sake of simplicity, enter a coefficient of 1.00 for both the input material
and the product. The unit is kg for both entries so that no material is lost, and
the process is mass-balanced.

Figure 6: Process specifications

Tutorial 1
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After entering the coefficients, the process is specified and the warning sign
disappears.
Alternatively, a coefficient of 100 could be entered on both sides to
obtain a ratio of 1:1. The possibility to enter any coefficients is very
helpful in case of unknown values of a process. Say a process
requires 70 kg of input material to produce 120 kg output material.
Both values can be written in the specification editor instead of
calculating the ratio.
Note that adding the material on the output side results in a change of the
respective font to bold and of the Material Type to Reference Flow. This happens
because the product is connected to a system output place and therefore leaves
the system. Any product that leaves the system is considered a reference flow
and is assumed to be (one of) the functional unit(s) of the network.
For further information about the topics of reference flows and
functional units in Umberto, have a look at the Umberto User
Manual. The user manual can be accessed directly in the software
via the Help menu.

Expanding the Model
In this example, the process labeled 'Process 1' needs electricity to process the
input material to the (intermediate) product.
Enter a new input place above the process and connect it to the process. Name
the new input place Energy. To avoid the arrow crossing through the name
label of the input place simply drag the label to another position, e.g. above the
place.

Figure 7: The expanded model with an energy input to Process 1

A material entry for the incoming energy has to be added to the process. Insert
a new material entry called elctricity, high voltage and make sure to choose
Energy as unit type.
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The field Place in the specification editor now shows three question marks for
the newly added material. The reason for that is that there are now two input
places for the process.
Click the field Place and choose the right input place for the newly inserted flow.
Next, add a coefficient for the entry 'electricity, high voltage'. Let us say the
process requires 0.5 MJ of electricity to produce 1 kg of product.
Change the unit of the electricity in the specification editor to MJ and enter a
coefficient of 0,5.
A comma (',') is used as the decimal point. Type '0,5' not '0.5' for
the coefficients in the process specification window. Otherwise, a
message will be prompted to confirm the right value.

Figure 8: Specification of Process 1 with electric energy input

The first process of the exemplary production network is complete by now and
will be the basis for the first network calculation.

Calculating the Flows of the Model
The network is specified and almost ready to be calculated. In order to calculate
the network, a starting point for the calculation has to be defined. In Umberto,
this is the so-called manual flow.
A manual flow determines the process level, or, in other words, how much of a
product is actually produced. This can be one unit of the product (e.g. with a
weight of 500 grams), but also, for example, the yearly production output of a
process (e.g. 250 tons). Such a manual flow is entered into an arrow. In most
cases it is the output flow at the end of the process chain, but a manual flow
can also be placed as an internal flow anywhere else within the network.
To set the manual flow in the network, select the arrow between Process 1 and
the output place: From the list of materials in the Project Explorer drag the entry
product to the Specification pane (make sure the arrow is still selected!).

Tutorial 1
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Next, the quantity of the manual flow has to be defined. Enter 100 kg as the
quantity of the manual flow.
Watch the arrow turn purple, thus indicating that this is where the manual flow
that triggers the model calculation has been entered. The network is now ready
to be calculated.

Figure 9: Arrow specification for a manual flow

To calculate the flows of the model open the dropdown menu next to the
Calculate button
in the net editor toolbar and choose Calculate Total Flows
from this menu. Alternatively, choose the command Calculate Total Flows from
the Calculation menu in the main toolbar.
After a successful calculation, all arrows change their color from grey to black
(except for the manual flow, which stays purple). Additionally a new tab will
open up in the Specification pane at the bottom. It lists all materials entering
the processes of the model with their quantity on the left side, and the
exchanges leaving the system on the right side.

Figure 10: Input/Output Inventory

Note that at this stage of the tutorial with a very basic model, this inventory
only contains few entries. However, the same procedure is applied for models
that are more complex.

Expanding the Model
The model will now be expanded.
First, change the type of the output place to connection. This can be done by
activating the output place and choosing the type Connection in the Property
Editor.
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Figure 11: Property Editor for the place

Now add another process to the right of the new connection place. Activate the
label of this process and rename it to Packaging.
Add an output place to its right and connect the packaging process to it. Apart
from the connection to Process 1, the packaging process needs a further input
place from where the packing material, namely boxes, is delivered. The model
should now look similar to Figure 12.

Figure 12: Expanded process model

Tutorial 1
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Note that the former output place (P2) is not a system boundary any more, but
lies in the middle of the model. If desired, rename the place P4 to Box of 12
units and remove the label 'P2: Output' by unchecking Display ID and Display
Text Label from the Properties pane of the connection place (compare to Figure
11).
The packaging process is still not specified. To do so, some additional flows
(materials) are required: Add two new materials to the Project Materials group
named packaged product and corrugated board box. Both materials have
the unit type Mass (kg), and both have the material type Good.
Next, add the material product to the input side of the packaging process. Add
the material packaged product to the respective output side. The corrugated
board box is another input material.
Imagine that the weight of the corrugated board box for 12 units of product
amounts to 600 grams. One product has a weight of 250 grams. Hence, the
total weight of 12 units of product adds up to 3 kg. The filled box, including the
packaged products, has a total weight of 3,6 kg.
There are two ways of specifying the packaging process. The first way is to work
with the total weight of 12 units that are packaged in one box.

Figure 13: Alternative process specification for the packaging: per 12 units…

Alternatively, the weight of the corrugated board box input can be scaled to one
unit (600 grams weight divided by 12 units = 50 grams per unit). The field
'Function' can be used to type in a formula, and to determine the coefficient
value.
Type 0.25+0.6/12 in the Function field, which will convert to 0,30 kg.
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Figure 14: …or per one unit

Note that it is not important which way the process is specified, as long as the
relation between the flows remains the same. The actual flow quantities are
determined during the calculation of the full model only, and depend on the
quantity of the manual flow entered for the model calculation.

Analyzing the Results
After specifying the packaging process, calculate the model once again.
For the calculation to work, usually only one manual flow in the network has to
be defined. This manual flow does not have to be located in an arrow that leads
to an output place, but can also be placed elsewhere within the model.
Only the Total Flows (SHIFT+F9) need to be calculated. At this stage only the
actual physical flows (material and energy flows) related to the process system
are considered.

Figure 15: Inventory of the process model, including a production and a packaging process

Sankey Diagrams
Next to the calculation button in the network editor toolbar, there is the button
for the Sankey diagram mode. With this button, the Sankey visualization can be
switched on or off. Once a network has been calculated, it is possible to visualize
all material flows with Sankey arrows.
Sankey diagrams were invented by Cpt. Sankey in the late 19th
century. He used them to visualize the energy (in-)efficiency of
steam engines. Each arrow width corresponds to the flow quantity,
so that an increase of a quantity by 50% leads to a Sankey arrow
with a 50% wider arrow magnitude.
If the Sankey mode is not enabled use the Sankey button to switch it on. The
model in the Sankey diagram mode should now look similar to Figure 16 below.

Tutorial 1
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Figure 16: Sankey diagram of the model with arrows displaying the flow quantity

In the Properties pane, a tab called Scaling of Sankey Diagrams is now available.
Bring the respective tab to front and scale the Sankey arrows up or down. Each
unit type (here: Mass and Energy) can be scaled separately or even switched
off so that important information can be highlighted without overloading the
image.

Figure 17: Scaling of Sankey Diagram

Please notice that the arrow representing the flow of corrugated board box from
the place Packaging Materials to the packaging process does not show a spike.
Hence, it is not explicitly clear in which direction the flow runs.
To visualize even small arrow spikes, turn on the option Spikes for arrows up
to: with a value of 5 px. Or, activate the option Always draw arrow spikes. Both
options are available in the Properties pane of the net diagram. To bring it to
front, click on an empty area of the Net Editor, or use the command Properties
from the context menu of the net editor area.
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Figure 18: Setting arrow spikes

Once the arrangement of the model and the scaling of the arrows is done, it can
be copied (CTRL+A to select all, CTRL+C to copy) to the clipboard and pasted
to other applications. This way, actual representations of a model can quickly
be added to a Power Point presentation or a report.

Using the Module Gallery
In the next step, a process will be copied to the 'Module Gallery' and afterwards
be pasted to the same or another model.
The Module Gallery in Umberto allows storing a model or a part of
a model as a module. Stored modules can be used in every model
of any project by dragging it from the Module Gallery onto the net
editor directly.
Go to the Project Explorer and bring the tab Module Gallery to front (tabs are
located at the bottom of this pane). Select the folder Modules and press the
Create Module Group button
in the Module Gallery toolbar. Alternatively, use
the context menu.
Rename the module group to Tutorial by using the 'Rename Module Group'
button
from the toolbar or the associated command from the context menu.

Tutorial 1
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Select the process Process 1 in the net editor and click the copy button
on
the main toolbar. Note that when copying a process all adjacent places will be
selected and copied, too.
Instead of using 'Copy', 'Cut' and 'Paste' commands the shortcuts
'CTRL+C', 'CTRL+X' and 'CTRL+V' can also be applied.

Mark the module group Tutorial in the Module Gallery and use the Paste
Clipboard Data to Module Group button
in the Module Gallery toolbar
(alternatively use the context menu).
Notice a preview thumbnail and the name of the module in the bottom section
of the Module Gallery. To change the name of the module, select it and use the
Rename selected Module button
(compare to Figure 19).
Rename the module to Simple Process.

Figure 19: Module Gallery

Now, that there is a basic process with adjacent places stored in the Module
Gallery that module can be copied into the existing model.
Select the module and copy it to the net by using the Copy module to net button
. Or simply add it to the model by using drag&drop. Click and hold the left
mouse button on the module and drag it to the net editor area.
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The command copy&paste can also be used within a model. For
educational purposes, the copied net model section has been copied
to the Module Gallery first.

Figure 20: Copying a model section to the Module Gallery, and retrieving it again.

The newly inserted model section can now be connected to the existing
structure. The process specification has to be adapted to account for the
additional input of product from the other process chain.
Merge the connection place with the connector plug symbol by dragging it onto
the existing connection place.
Note that the manual flow that was entered into the output arrow of the process
section before it was stored to the Module Gallery has not been maintained. In
order to make the newly inserted process section calculate properly, enter a
manual flow product with a quantity (e.g. 100 kg) in the arrow that leaves the
copied process and is linked to the connection place.
The small tutorial model has two production lines now, which each deliver a
certain product quantity. The outputs of both are going to the packaging
process.

Tutorial 1
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Figure 21: The newly inserted model section has been connected by merging the places

It is possible to return to the previous stage of the model (without the inserted
second supply chain) by clicking the Undo button as often as necessary.

For further information about the functions covered in this tutorial,
have a look at the Umberto User Manual. The user manual can be
accessed directly in the software via the Help menu.

Thank you for completing Tutorial 1. Please continue with Tutorial 2a
or two 2b to discover more practical features of Umberto.
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